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Wholesome goodness you can share.
Here are just some of  the features that make YummySoup! so great:

Support for both Metric and Standard measurements.
Professional-quality themes for viewing, printing and emailing.

Photo paper, index cards, and Letter print & email formats.
One-click automatic imports from most of  the popular recipe sites.
The most intuitive web and document importer. So easy your 5 year old can master it.
Recipecasts deliver your recipes directly to friends and family.
Super smart Grocery Lists.
Keywords make everyone’s life easier. Grandma’s cookie recipe will find its way into your desserts.
Schedule your dinner parties ahead and remember who loved your signature dish.

With the full featured full screen view get away from life's distractions and focus on the recipes!
Scale your recipes just for two, or maybe ten when you want to share.
Notes you share and private notes you keep to yourself.
Open standard XML exports, because it’s fair.

Updated Friday, August 26, 2011
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The Weekly Planner can 
be opened and closed 
with the toggle button 
labeled “Weekly Planner” 
at the bottom right of  the 
main window.

Adding a recipe to a day 
in the Weekly Planner is 
simple, just drag a recipe 
from the selection area 
above the recipe display 
into one of  the days in the 
Planner. Add all the 
recipes you plan to make and reorder them using standard drag and drop. You can even drag a 
recipe from one day to another to reschedule. Hold down the option key while dragging a 
recipe from one day to another to copy it rather then move.

Need to flip between the recipes you plan to make on Mom’s birthday? Just click the recipe in 
the Weekly Planner to view it. Even use your keyboard to flip between the recipes.

Click on the title of  the day for a handy menu to add a note for that day.

There’s a Calendar button to make quick work of  finding far off  days and even a list full of  all 
your scheduled parties.

Change your mind and want to remove a recipe? Just select it and press the delete key above 
the return key.

Note: Typed in entries are on my todo list - a great suggestion by so many users!

Weekly Planner
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I’ve had countless users tell me 
that their young children love to 
use this feature! It’s so easy and 
makes quick work of  recipes on 
websites and text documents. 

Even Pages and Word 
documents can be imported in 
seconds. If  you have a scanner 
and it supports scanning to text, 
otherwise known as OCR (optical 
character recognition), you can 
import your recipes from your 
cookbooks too!

Most of  the popular recipe sites 
are supported with one-click 
imports. These sites are listed in 
the Web Importers toolbar. You can find the Web Importer in the main window’s toolbar and 
under the Window menu. You can also use the keyboard shortcut ⌥⌘W. 

When viewing a web page that contains a recipe and Web Importer detects a recipe on the page 
the Import button will turn blue. This means that with a single-click of  the of  the Import 
button, your recipe will be imported. You can say it’s magic!

If  YummySoup! doesn’t detect a recipe then just use the highlight method. Highlight the 
name of  the recipe and then click the Name button. Do the same for the ingredients, directions 
and before you know it you’ll have an easy to understand colorful representation of  how 
your recipe will be imported. When you’re done press import. 

For your text documents the Web Importer has a text entry box you can paste the entire contents 
of  your text file. Click the “ T ” button in the toolbar to open it.

Lastly the Web Importer features customizable bookmarks. Add sites with the “ + ” button to 
the left of  the address bar. View your custom bookmarks with the  icon.

Note: There is even a handy right-click menu to assign your highlighted text. The automatic 
ingredient sorter is a learning one. If  it doesn’t sort your ingredients correctly, fix it and the 
next time it will remember your new measurement. 

Web Importer
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Add your own recipes 
by either pressing the 
“ + ” button under the 
recipe selection view 
or simply selecting 
New Recipe from the 
File menu.

The recipe editor is so 
self-explanatory that 
little is required to 
master it. There are 
however a few keys to 
making recipes that 
pop! On the top right there are image wells you can drag and drop pictures to. The first picture 
is the one that is displayed at the top of  each recipe and in the recipe selector view. Additional 
image wells are provided for directions and notes; steps that are best shown visually. Drag and 
drop from the image well into the directions in the location that you want the image to be viewed 
and printed. Use as many available images per step as you like.

Having guests come for a celebration? Scaling your recipes is simple with the Scaling 
Assistant and it’s found under the ingredients table. Rather then scaling your original recipe a 
duplicate will be created, after all it’s usually for special occasions that we need to scale our 
beloved recipes.

We tend to makes notes about our recipes. Because it’s so easy and fun to share recipes with 
YummySoup!, you might not want all notes to be shared. Maybe one guest didn’t like your 
prized creation and you need to remember not to serve it to them in the future. With Private 
Notes you can jot it down and not worry, it’s for your eyes only. Notes and Private notes are 
accessed to the right of  the recipe title with a handy button.

Note: There is a handy right-click menu to insert ingredients above or below and to convert 
ingredients to groups headers.

Recipe Editor
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We love to share our recipes but 
not everyone owns a computer (let 
alone an awesome Mac). Not only 
that but when we have dinner 
guests over, there is nothing like 
having beautiful recipes printed on 
photo paper at the table awaiting 
our guests.

Print them out to replace your 
index cards or create a heart-
warming gift. A customer 
recently told me how she used YummySoup! to give the gift of  passing on her family recipes to 
her granddaughter. “ I used your program to make a 4 x 6 photo album into a recipe card cook 
book for my grand-daughter’s wedding gift and it turned out wonderful. ”

With printing and emails you are presented with the same customization panel where you can 
select the theme and format you want to use. There’s even an “ Alternate ” button to change 
the layout, moving the ingredients under the description rather than under the main picture.

Above the format selection there is a handy control to increase or decrease the font size and 
even buttons to toggle parts of  the recipe to be included. Often removing the additional 
metrics or additional images will allow a recipe to be printed on just one index card. 

The preview is a live representation and includes the page counter at the bottom if  the recipe 
requires more than one page.

Emails are in rich text & image PDFs capable of  being printed out in the same quality of  the 
printouts themselves. Included with the PDF is a handy export file that can be imported into 
your recipient’s copy of  YummySoup!.

Note: Emails with such rich content require Apple’s Mail.app. You can switch to plain text 
emails in YummySoup!’s preferences which will work with any default email client.

Printing and Emailing
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With YummySoup! you can make 
quick work of  any trip to the 
grocery store. Features such as 
ingredient consolidation and 
ordered aisles help get your 
shopping done quickly. Creating 
your list is equally fast with a super 
simple way to exclude sections of 
a recipe for when that store bought 
pie crust in your freezer will do. 
There is even a dedicated section to 
enter your own items.

Start by creating a new list with the “ + ” button bellow the sidebar. Now just drag and drop 
recipes into your grocery list.

In the “ Recipes ” view you’ll see a breakdown of  all the ingredients from the recipes in your 
list. You can even click on a recipe to jump to its location within the list! If  there is a part of  a 
recipe that you don’t want, say the ingredients for a pie crust and you would rather just use the 
frozen one in your freezer, select it and click the exclude button.

The “ My Entries ” section is where you can add your own items to the list. Laundry 
detergent, Milk, Flour, Baby food, etc. These items when printed or emailed will show up within 
your list, categorized by aisle along with your other ingredients. They will be preceded by a “ * ” 
as a handy reminder.

Last is the “ Consolidated ” view. Here you will find the ingredients from your recipes 
consolidated and ordered alphabetically. To add ingredients to your printed or emailed list 
click on the Needed checkmark. There’s even a shortcut, just click on the word Needed in the 
header to check or uncheck all of  the ingredients at once! 

Ordered ingredients by aisle are just awesome. You can add or modify the existing aisles and 
the order in which they’re printed by clicking on the Aisles button. Just drag them into the 
order that suits you best. 

Grocery Lists
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Recipecasts require a MobileMe 
account to publish but anyone can 
subscribe to one.

Akin to Podcasts in iTunes and 
Photocasts in iPhoto, 
Recipecasts enable you to 
broadcast your recipes directly to 
your friends and family’s 
YummySoup! (if  they subscribe!). If  
you change to your recipe, your 
subscribers will automatically receive 
the update.

You can publish your entire recipe 
library or any regular or smart group 
and it’s so simple.

From the Social menu in the toolbar 
select Publish Recipecast. Enter your 
MobileMe username and password 
and click Continue. Select the group 
you want to publish and click OK. 
Now enter the name of  the 
recipecast you want everyone to see, say for example, “Mom’s Recipecast”. Click OK and your 
recipecast will be created and published.  Click the Recipecast address to go to your Recipecast 

web page where you will find handy links to 
email, tweet and post your Recipecast on 
Facebook. Users can even subscribe to your 
Recipecast right from this page.


 
 
 
 
 
 
                                     

If  you want to change the published name of  your Recipecast just double-click the published 
group to edit it. You can even Unpublish your Recipecast right from here. The Recipecast web 
address is listed here too, just in cast you need to tell more people about it.

If  you want to change the name of  a subscribed Recipecast just double-click the Recipecast to 
edit its name. To unsubscribe to a Recipecast, delete it as you would with any other group from 
the File menu or by right-clicking it and selecting Delete Group.

Recipecasts
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Here is an explanation of  some of  the inner 
workings of  Recipecasts.

When you subscribe to a Recipecast you are 
subscribing to the entire group that has been 
published. Any additions, deletions and 
changes made to recipes within that group will 
be published to you. 

Now you might not like every recipe within that 
Recipecast, so we got you covered! I am a 
vegetarian myself, so the first thing I do when I 
subscribe to a Recipecast is use the search box 
to look for chicken, beef, pork, etc. I select my 
found recipes all at once with ⌘A and click the 
“ - ” button. I am still subscribed to the 
Recipecast and those recipes are still being 
published, but I won’t receive them anymore or 
updates to them. Brilliant!

To add a little more magic we’ve made it really 
easy to save recipes from Recipecasts too. If  you found a recipe you want a copy of  for yourself  
just drag and drop it into your “My Library” group. You can also drag it right into a day 
within the Weekly Planner and it will automatically be copied into your own collection. When 
a recipe is copied from a Recipecast it will no longer be visible within that Recipecast. This 
makes it very easy to find recipes that you haven’t yet considered. Best of  all you will still receive 
updates to copied recipes if  you wish. If  the publisher makes a change you will be notified and 
will have the option to receive the update or skip the update and no longer receive updates for 
that recipe.

Recipecasts Continued
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YummySoup! uses keywords to assign recipes to groups. If  a recipe has the keyword 
“Desserts” then it will show up within your Desserts group. 

This makes sharing recipes amazing! If  someone sends you a recipe for this wonderful carrot 
cake they just made and it has the keywords “Desserts” and “Cakes” then it will automatically be 
filed away in your Desserts and Cakes groups. 

These keywords go well beyond being useful for just sharing. Because recipes are assigned to 
groups based on keywords, feel free to delete a group without fear. If  you add the group back 
the recipes will be automagically be assigned to it. If  Grandma sends you a bunch of  Holiday 
recipes and she used the keyword “Holiday”, just add that group to your collection. Simple!

If  you need to remove a keyword from a bulk of  recipes just create a group with the name of  

the offending keyword, select all the recipes within that group with ⌘A and click “ - ” and select 
“Remove From Group”. You can also rename a group and select to change the keyword within 
the recipes to match the new name.

Keywords & Groups
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Smart groups use rules that you can 
set to determine which recipes 
show up within them. 

One question I get a LOT is 
“How do I get my recipe into the 
‘My Favorites’ group?”

Well, the “My Favorites” group 
and the “Recipes To Try” groups 
are smart groups and here is how 
they work and how you can get 
your favorite recipes into them!

My Favorites will show you all 
recipes that have a star rating of  4 or greater and are flagged as previously prepared. You 
can edit your recipes to apply star ratings and click the Previously Prepared toggle button. 

The Recipes to Try smart group shows you all recipes that are not flagged as previously 
prepared. Simple and really convenient!

Create your own smart groups and come up with some fantastic ways to sort and discover 
your recipes.

Smart Groups
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Fully Featured.

With the full screen view you 
can “get away” from your 
desktop and focus on what’s 
important, those recipes!

Move your mouse to the bottom 
of  the screen and you get a 
handy toolbar to Edit, 
Email and Print your recipes, 
all without having to jump back 
to your desktop. There is even a 
handy button to toggle the 
Theme Selector, shrink and enlarge the text and of  course get back to your desktop.  

Move your mouse to the top or the left and the full navigation comes into play. You have full 
access to the sidebar and the recipe selector. You can even use the left and right arrow keys to 
flip from one recipe to another.

 

Full Screen View
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Themes are used not just 
for viewing but for 
Printing and Emailing  
too!

Rather then having to 
dig into your preferences 
the Theme Selector is 
conveniently  presented 
right next to the display 
itself. You can toggle it 
from the View menu or 
simply press ⌘T for 
quick access. You can 
even use the Theme Selector within the Full Screen view. You even have an “ Alternate ” 
button for a slightly different layout.

Themes
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With Smart Measurements you can 
achieve blissful consistency 
with measures. You can find this 
feature within the Preferences. 

YummySoup! comes with most measurements already set but you can edit them and add 
your own. In this example if  a recipe is entered or imported with a measurement of  T, 
tablespoon, Tablespoon, Tbsp or tbsp then the measurement will be converted to the selected 
Smart Measurement, ‘ Tbsp ’.

 If  you prefer to use Tablespoon over Tbsp, then in the Smart Measurements column just 
rename the two Tbsp entries to Tablespoon and Tablespoons.

Smart Measurements
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Anytime a Match is 
found it will automatically 
be renamed to the 
corresponding
Smart Measurement.
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YummySoup! for iOS is finally here. In its initial release you 
get a basic reader app that just allows you to search and 
display your recipes including the ability to tap on directions 
to highlight them so you won’t lose your place. 

I have big plans for the iOS version all which will be free 
upgrades from this initial release. I am currently working on 
version two which is a full editor featuring iCloud sync and 
will require iOS 5 when it’s released. So until version two is 
released here are the directions for syncing your library to 
your device. (Sorry, I know it’s a bit tedious!)

Step one:
Starting with version 2.4 of  YummySoup! you have a handy 
menu command to reveal your library file within the Finder. Choose YummySoup! - Library - 
Show Library File in Finder. Note: You can move your library file to another location but if  you 
do make sure to double-click it to assign the new location YummySoup!.

Step two:
Connect your iDevice to your computer and launch iTunes. Click on your device in the sidebar 
and under the Apps tab scroll to the File Sharing section and you will see YummySoup! as one of 
your entries. Select it and then from the Finder drag and drop your library file into the 
YummySoup! Documents section in iTunes. Note: You will need to repeat this last step every 
time you want an updated version of  your library on your device. 

Note: If  you don’t have 2.4 or greater installed you can locate your library manually. It’s either already 
located in your Documents folder or in ~/Library/YummySoup!/. To get there open the Finder and 
from the Go menu select Go to Folder... and type “~/Library/YummySoup/”. You can drag this library 
file to any location you like and then double-click it to assign the new location to YummySoup!.

iPhone, iPod touch and iPad
YU

M
M

YS
OU

P!
 U

SE
R 

GU
ID

E



15

You can share one YummySoup! recipe library with two 
user accounts on the same machine or even over the 
network. Even use your Dropbox or iDisk to sync over the 
internet.

By default your recipe library will be saved in your 
Documents folder named “YummySoup! Library”.

Between user accounts on one machine:
Be sure to quit YummySoup! first. Move your 
YummySoup! Library file to the Shared folder which can 
be found in “Macintosh HD/Users/Shared”. Once you 
move your recipe library right-click it and select “Get 
Info”. At the bottom under “Sharing & Permissions:” add the other user accounts that will be 
accessing the library. Make sure you give them Read & Write permissions. Now double-click 
the library file to launch YummySoup! and assign the new library location. Logout and for each 
additional account double-click the library file to assign it. 

Over the network: 
Be sure to quit YummySoup! first. Make sure you have File Sharing turned on within your 
System Preferences under Sharing. Keep your YummySoup! Library file in a location where it 
will be shared and make sure that the user account that connects to your machine will have 
Read & Write permissions over the network to it. On your second computer navigate to the 
shared library over the network and double-click it to assign it to YummySoup!.

Over MobileMe & Dropbox:
Be sure to quit YummySoup! first. Move your library file to your iDisk or Dropbox folder and 
double-click it to assign it to YummySoup!.

Note: Currently only one copy of  YummySoup! can access a library file at a time so make sure 
you quit one copy before launching the next. There is a safety mechanism in place that will 
prevent saving the library if  two copies access it at the same time.

Sharing a Library
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If  you are interested in creating your own custom 
theme all that is required is mild proficiency in 
HTML and CSS. The best way to start is to right-
click the YummySoup! application and select 
“Show Package Contents”. Now open the 
Contents/Resources/Themes folder. Select the 
theme you would like to tinker with and COPY it 
to ~/Library/Application Support/
YummySoup!/Theme Development”. Now 
rename the copied folder as you can’t have two 
themes with the same name.

Peak around the folder structure, it’s self  
explanatory. Under the Print Templates folder are 
the folders for each format. You can create more 
formats by simply creating a new folder.

Themes work by replacing commented keys within 
the HTML and CSS. For example the title is 
injected with “ <!--recipe_title--> ”. There are 
other keys such as this one that hide the div layer 
used to display the picture if  there isn’t one, 
“ div#recipe_picture {/*picture_hide*/} ”. 
Others include, “ <!--fontSize--> ” and 
“ <!--minHeight--> ” to inject integers, the first to let 
the user change the base font size and the later to allow a div layer to grow with the height of  a 
display view. Just create an empty recipe, the paper from the Desk theme will grow/shrink after 
you resize the window. Note: minHeight works with “ minHightOffsetValue ”.

Printouts are a little more complex. At the top of  the CSS portion the important keys are 
pageWidth and pageHeight that set the paper size (in 72dpi). Use printOrder for the order they 
are drawn to the page and placementRules for when one layer must always be drawn after 
another.

Note: We used Coda from Panic Inc. to create all our themes and website. We LOVE it!

Theme Creation
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Wednesday, May 4, 2011
	 Updated the Sharing a Library page and added this revisions page.

Friday, August 26, 2011
	 Added iPhone, iPod touch and iPad page.

User Guide Revisions
YU

M
M

YS
OU

P!
 U

SE
R 

GU
ID

E


